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Main Meeting, April 3 
We will let you know by email on who the speaker will be. (See page 3)     

Super prizes for our April raffles (See page 4) & March raffle winners’ pix (Page 17).  
 

Happy 35th Birthday NOCCC! Join Our Party April 3rd. 
 

We will have a Consignment Table and E-Waste Collection during the April 2011 meeting. (See page 5) 
 

View/Download this newsletter and prior issues too at www.noccc.org – all in color! 

Special Interest Group (SIG) & Main Meeting 

9:00 a.m. 
Linux for Desktop Users………....................Science 131 
Topics about the Linux operating system.  Beginner’s Qs here 
also. 
 
Visual Programming..……………………..….Science 111 
Visual Basic, Visual BasicScript, Visual C++ and Visual J++   
for Beginners. 
 
Microsoft Word, Excel, and Outlook…….…Science 109 
Topics about these three parts of the Microsoft Office Suite. 
 
Beginners Digital Photography……..….......Science 127 
Making good photos, the Aspect Ratio tool, & sharing photos. 

Reviews & Consignment Tables, Coffee & Donuts: Irvine Hall Lobby 

10:30 a.m. 
Beginners PC Q & A ......................................  Irvine Hall 
Beginners’ questions about PCs. 
Linux Administration………………...............Science 131 
More topics about the Linux operating system. 
Visual Programming for Apps (VBA)………Science 306 
Using VBA to customize your program by using the built-in 
wizard feature.  Access & Excel VBA code.    New Time 

10:30 a.m. 
Advanced Digital Photography………………...  Science 127 
Using available lighting.. 
 
Understanding Operating Systems………….....Science 111 
Help with DOS, Windows, OS/2, etc. 
Mobile Computing – New!................................. Science 109 
This new SIG discusses devices running the open-source Android 
operating system. 

12:00 Noon 
PIG SIG………………………….………..Hashinger Courtyard 
 
 
 
 
 
 
Microsoft Access – New Time…………......……Science 306 
Database applications and more.  

12:30 p.m. 
Advanced PC Q & A…………………….......…….…Irvine Hall 
PC hardware & software topics. 

2:00 p.m. Main Meeting…….…..Irvine Hall 

NOCCC website: 
http://www.noccc.org 

Future Meeting Dates in 2011: 
May 1 

Ted
Sticky Note
This PDF file has internal & web (both e-mail & Internet page) navigation links for your convenience. Your mouse pointer will change from an open hand to one with a pointing finger when it is on a live link. Happy Reading!

www.noccc.org
http://www.noccc.org
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Publication Chairman - Oversees publication tasks and converts the 
Orange Bytes newsletter to PDF for printing and web posting; transmits 
PDF to Printer. 
Ted Littman.................................(714) 779-1936, tedlit@roadrunner.com 
 
Editor - Edits and makes final selections of the articles to be included in the 
newsletter. 
Ted Littman...................................................................  editor@noccc.org  
 
Associate Editor/Production - Receives articles from the editor and lays 
out the issue of the newsletter. 
Ted Littman...................................................................  editor@noccc.org 
 
Circulation - Oversees mailing and distribution of the newsletter. 
Richard Miller .................................... (714) 309-1504, rrrmil@gmail.com 
 
Reviews Editor - Communicates with the vendors and members who 
evaluate products and write reviews.  Makes sure members meet deadlines.  
Sends a copy of the newsletter to vendors of products we review. 
Ted Littman...................................... (714) 779-1936, reviews@noccc.org 
 
Copy Editor - Does final proof reading of the newsletter for typos and 
misspellings. 
Dennis Martin…………….(951) 926-3065, dennismartin@dslextreme.com 
 
 
VOLUNTEERS NEEDED 
 
The following positions are available: 
 
Contributing Editors - Write articles for the newsletter.   
 
Commercial Swap Meets - Distributes the newsletter and NOCCC flyers at 
swap meets.   
 
Commercial Advertising - Obtains ads from vendors for the newsletter.   
 
Classified Advertising - Obtains computer-related, non-commercial ads for 

the newsletter free to NOCCC members.   

Contact editor@noccc.org or (714) 779-1936. 

Celebrating 35 years of
“Friends Helping 

Friends” 
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April 3rd  Main Meeting 

 2 p.m. Irvine Hall 
Jim is leaving no stone unturned to obtain a 
speaker for the April Main Meeting. But, he does 
not have a commitment as of this writing. You will 
be notified by email before April 3rd as to who the 
presenter will be. 
 

President’s Message 
By Jim Sanders, NOCCC President  

There are a number of points that I 
want to touch on in this month's 
column. First is a reminder that 
we still have a fair number of the 
new club T-shirts available. So if 
you haven't purchased yours yet, 
ask about one at the next meeting. 
Second, are a few words about 
volunteering. There are quite a 
few tasks that need to be 
accomplished each month in order 
for the club to run smoothly. 
Currently, there are not enough volunteers to do everything that 
needs to be done. There are limits to how much time the 
volunteers that we currently do have can devote to club 
activities. The result, in typical squeaky wheel fashion, means 
some things just do not get done or are not done as well as we 
would like. 
 
We need, leaders for new SIGs, help with the morning set up 
and the afternoon tear down and pack-up, help with a number of 
activities involved in getting the newsletter out each month, we 
need a backup editor for the newsletter, we need help with the 
Reviews table, and the list goes on. Especially for those of you 
who are retired, finding a few hours a month to help with some 
of the club activities shouldn't be that difficult. 
 
This month’s speaker, Mitch Siegel, talked about social 
networking in general and Facebook, Twitter, and LinkedIn 
websites in particular. One of the points that he made, and I 
would like to repeat it, is that volunteering for any one of a 
number of positions within the club is a good form of 
networking. Not only do you get to form closer relationships 
with the other volunteers, but frequently the tasks that you 
perform bring you into contact with quite a few other people. 
The opportunity to make new friends and expand your horizons 
can be quite beneficial. 
 
When Mr. Siegel queried the audience about why some of you 
have not tried Facebook, one of the responses was that it would 
take too much time. He agreed that if you didn't take advantage 
of some of the controls that Facebook offers this could be true. I 
found it interesting that the March 11 edition of the Orange 

County Register, page 4 of the business section, had an article 
headlined "Facebook doesn't have to be a drag on time, energy." 
The article went into a fair amount of detail about how you can 
limit the number of things that can take up your time, and some 
that would improve your privacy. I found it a worthwhile read. 
 
One of the items that came up at this month’s Board of 
Directors meeting is our upcoming election in June. All of the 
current officers and Board members agreed (a couple somewhat 
reluctantly) to having their name put on the ballot to serve 
another term. However, we do not currently have a Vice 
President, and we are shy at least one Board member. I would 
appreciate it if each of you would do a little soul-searching and 
come to a decision that you can have your name put on the 
ballot for one of these positions. The ballot will be published in 
the May edition of the Orange Bytes, so please make that 
decision in time for that publication. 
 
 See you next month! 
 

Orange Bytes in Color and More  
at the NOCCC Web Site. 

Webmaster Needed! 
By Steven Breitbart, NOCCC 

Jim Sanders, the NOCCC President, has been updating the 
NOCCC web site.  Nevertheless, we urgently need a 
volunteer to be the Webmaster.  If you can help, contact Jim 
Sanders at president@noccc.org or (714) 544-3589. 
 
The latest issue of the Orange Bytes is now available in PDF 
format, in color and with live internal and external links. There 
is no user name or password needed.  Older issues also are 
available.  Go to our website: http://www.noccc.org/bytes/index.html. 
 

Current Slate for June 2011 
NOCCC Elections  

By Steven Breitbart, NOCCC 

President: Jim Sanders 
Vice President: open 
Treasurer:  John Heenan 
Secretary:  open 
 
Director:  Steven Breitbart 
Director:  open 
Director:  Mary Cornett 
Director:  Dallas Hazelton 
Director:  Ben Lochtenbergh 
Director:  Richard Miller 
Director:  Gerry Resch 
Director:  Gordon Strickland, Jr. 

mailto:president@noccc.org
http://www.noccc.org/bytes/index.html
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s a valued member, we bring you a section of discounts 
and offers as part of the entire “Benefit of Belonging.”  
(Caveat: we are unable to endorse these companies, but 

make these offers available as a service to our members.) 
 
User Group Offers - Software and Hardware 
 
User Group Relations – You can now order the latest release 
of Acronis True Image 2011 from Gene Barlow for only $25 
(download) or $25 plus S&H (on a CD). This top-rated backup 
utility has many new features and will work with Windows 7. 
Use the following link for special pricing for user group 
members: www.ugr.com/TrueImage.html.   
 
Techsmith - You can get SnagIt 10, an outstanding screen 
capture program, and Camtasia Studio 7, to quickly record, edit 
and publish multimedia demos and presentations, bundle for 
$269, an $81 savings:  https://store.techsmith.com/government.asp. 
You can download SnagIt 10 alone for $42.95. 
 
User Group Offers - Books and Magazines  
 
Pearson Education Products including Prentice Hall 
Professional, Addison-Wesley Professional, IBM Press, Exam 
Cram, Que Publishing, and Cisco Press.  Get 35% off list price 
by purchasing directly from the publisher combo site: 
www.informit.com/join.  Sign in or create an account.  Enter 
the membership code “USERGROUP” (all caps).  Select your 
items and check out.  You are required to register and apply the 
code once, but you must be logged in to receive the special 
pricing.   
 
O’Reilly Books - Get 40% off all books and videos from 
O’Reilly, Microsoft Press, Pragmatic Bookshelf, and SitePoint, 
or 50 % off  books you purchase directly from O’Reilly.  Just 
use code DSUG when ordering online, www.oreilly.com/store/, 
or by phone, (800) 998-9938.  Free ground shipping on orders 
$29.95 or more in the US.  If for any reason you are not 
completely satisfied with your purchase, return it to O’Reilly 
and get your money back 
(www.oreilly.com/oreilly/cs/guarantee).  A return shipping label 
is included with every direct purchase and directions are posted 
online in case you misplace it. 
 
Peachpit Press Books Discount - Get 35% off by joining the  
Peachpit Club. Use the following hyperlink to sign up: 
http://memberservices.informit.com/my_account/login.aspx?partner=52 to 
sign up as a member.  User group members should note that 
once you have become a Peachpit Club member, you might use 
your user group coupon code ON TOP of the permanent savings 
you earn as a member of the club.  Just log into the site before 
you make a purchase to ensure this permanent discount will be 
in effect, and then enter coupon code UE-23AA-PEUF (case-
sensitive) at checkout!  This coupon code is an exclusive offer 
that may not be used in conjunction with any other coupon 
codes.  The offer applies to all titles at peachpit.com including 
New Riders, Macromedia Press, Adobe Press, and Peachpit.  

Free Internet Libraries - Upon retiring from college 
teaching/administration, Walter Antoniotti  began developing 
Free Internet Libraries for students, teachers, and professionals.  
(http://www.businessbookmall.com/Free Internet Libraries.htm) 
Of special interest to PC users are these free computer libraries: 
  Free Business Software 
(http://www.businessbookmall.com/Free Business Software 
Internet Library.htm) 
  Free Software Tutorials 
 (http://www.businessbookmall.com/Software Tutorials 
Internet Library.htm) 
  Excel Internet Library 
(http://www.businessbookmall.com/Microsoft_Excel_Directi
ons_For_Beginners.htm) 
 

THE APRIL 2011 CLUB RAFFLES 

 
GENERAL DRAWING PRIZES*: 

 Colby 4GB Video/MP3 Player/FM Radio 
 Green Laser Pointer 
 Patriot USB 802.11n WiFi Adapter 
 Norton Internet Security 2011 Software 

 
• Parking stubs are good for two raffle tickets each! 

 
MEMBERS-ONLY DRAWING PRIZES: 
 (Wear your NOCCC Membership Badge and get a free 
ticket!) 

 Wireless 6-in-1 FM Headphones 
 Dual USB Auto Charger 
 Norton Utilities Software 

 

Save Your Parking Permits! 
 

o offset the cost of parking in the Lastinger Underground 
Parking Structure, the NOCCC Board approved a motion 

to give each member two NOCCC General Drawing raffle 
tickets in exchange for the Lastinger-parking permit.  Turn the 
bottom-half “receipt” part of your permit to the Rafflemeister on 
the same day or hold it until the next meeting. Gerry will 
exchange it for two raffle tickets.  
 
The reason for this is that the NOCCC Board has found that 
some people are not attending meetings or not renewing their 
memberships because of the parking situation.  Chapman 
University has allowed us to park in the Lastinger Parking 
Structure under Wilson Field for only $2 for the whole day of 
our meeting; normally $2 is good for only two hours.  The 
advantages of parking there are clear; you don’t have to drive 
around looking for a legal spot (remember, don’t park on the 
private home side of the street), the car doesn’t get hot and you 
don’t have to parallel park.  There is even an elevator available 
to get down to the parking area.  Hopefully, the two raffle 
tickets, which would normally cost $2, will be a small incentive 
to get people to come to meetings and to remain NOCCC 
members. 

A 

T

Membership Benefits 

http://www.ugr.com/TrueImage.html
https://store.techsmith.com/government.asp
http://www.informit.com/join
http://www.oreilly.com/store/
http://www.oreilly.com/oreilly/cs/guarantee
http://memberservices.informit.com/my_account/login.aspx?partner=52
http://www.businessbookmall.com/FreeInternetLibraries.htm
http://www.businessbookmall.com/FreeBusinessSoftwareInternetLibrary.htm
http://www.businessbookmall.com/FreeBusinessSoftwareInternetLibrary.htm
http://www.businessbookmall.com/SoftwareTutorialsInternetLibrary.htm
http://www.businessbookmall.com/SoftwareTutorialsInternetLibrary.htm
http://www.businessbookmall.com/Microsoft_Excel_Directions_For_Beginners.htm
http://www.businessbookmall.com/Microsoft_Excel_Directions_For_Beginners.htm
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The NOCCC Consignment Table will be 
available during the April 2011 meeting in 
the lobby of Irvine Hall.  It is open on even 
months, the same as the e-Waste collection. 
For your information: 

1) Only current members can place items 
for sale, but non-members are welcome 
to purchase items from the table.  This is 
a great place to get some money for 
your surplus computer items, and help 
the NOCCC at the same time. 

2) The consignment table operates on a 
90/10% basis — with the owner getting 
90%, and the Club treasury 10%. 

3) You can fill out a Consignment Table 
User List and item tags at the table:  
The user list and each tag must contain:  
a) Seller’s name 
b) Seller’s NOCCC membership 

number 
c) Item name and description 
d) Item asking price 

4) The seller may pick up all items and/or 
money at any time, but no later than 2 
p.m. on the day of sale.  Any items 
and/or money not picked up by 2 p.m. 
will become the property of NOCCC 
and will be subject to disposal at the 
Club’s discretion.  The club has no 
storage room available for unsold items 

5) NOCCC is NOT RESPONSIBLE in any 
way for items bought and/or sold at the 
Consignment Table.  Each item is 
placed and sold on an AS-IS BASIS. 

 
California disposal laws have made it illegal 
to put monitors and computers in the regular 
trash.  Omni Technics, Inc. will be at our 
regular meetings to collect E-Waste on even 
months, so bring your “junk” in April.   
Check their web site for more information: 
http://www.ca-recycle.com/.  Or, call (562) 
627-1910. 

The area code for the following phone numbers is 714 unless noted. 
President 

Jim Sanders ........................ .544-3589..................    president@noccc.org 
Vice President 

Open......................................  
Secretary 

Ted Littman………………...779-1936……………. secretary@noccc.org 
Treasurer  

John Heenan ........................ .998-7660...................... treasurer@noccc.org 
 
Directors 

Steven Breitbart................... ..486-3070………    sbreitbart@socal.rr.com 
    Tia Christian………………... 263-6105……    lwilliams_00@yahoo.com  

Mary Cornett..................(949) 716-0779......  pacificblu.mary@gmail.com 
    Dallas Hazleton........................526-1592...    ghazleton4@dslextreme.com  

Ben Lochtenbergh……..(949) 653-2545…...….......……..  bal@msn.com 
Richard Miller ..................... ...309-1504...............  r r rmil@gmail .com 
Gerry Resch ........................ ...772-6667.............    gerry@gerryresch.com 
Gordon E. Strickland, Jr...........970-7730......... gestrickland@earthlink.net 

 
Editor 

Ted Littman... ...................... ...779-1936........ ..............    editor@noccc.org 
Webmaster 

Jim Sanders, Acting……….....544-3589…….…...… president@noccc.org 
Volunteers, Committees, and Projects 

 
 Consignment Table 

Richard Miller ..................... ....309-1504................. r r rmil@gmail .com 
 Raffle Leader 
    Gerry Resch ……………….....772-6667...............   gerry@gerryresch.com 
 Helpline 

Ted Littman......................... ....779-1936..............    tedlit@roadrunner.com 
 Membership Database 

John Heenan ........................ ....998-7660..................... treasurer@noccc.org 
 Membership Chairman 

Ben Lochtenbergh...........(949) 653-2545............................... bal@msn.com 
 SIG Coordinator 

Dallas Hazleton .................. ....526-1592........ ghazleton4@dslextreme.com 
 Programs/Speakers Coordinator 

Mary Cornett…………...(949) 716-0779......... pacificblu.mary@gmail.com 
 Public Relations. 

Mary Cornett……...........(949) 716-0779......... pacificblu.mary@gmail.com 
 University Liaison  

Jim Sanders ......................... ....544-3589....................  president@noccc.org 
 
 
Chapman U. Campus Security..997-6763........open locked rooms, problems 
_________________________________________________________________ 
 

 

Consignment NOCCC Officers 

 E-Waste Collection  

NOCCC is a Member 

http://www.ca-recycle.com/
mailto:president@noccc.org
mailto:secretary@noccc.org
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The Help Line is in the true spirit of the NOCCC, which is to help others to learn more about computers.  The 
following is a list of Help Line subjects that a NOCCC volunteer is able to help you with.  Call 
(714) 779-1936 or e-mail Ted Littman at helpline@noccc.org with additions, deletions, or corrections. Most 
volunteers prefer being contacted by e-mail. Mention NOCCC in the Subject line. 

Apple II Gerry Resch 714-772-6667  gerry@gerryresch.com 
Computer Boards Martin LaRocque 562-697-4318  6 - 9 p.m. 
Corel Draw Larry Klees 714-879-6405  larryklees@yahoo.com 
Digital Photography Larry Klees 714-879-6405  larryklees@yahoo.com 
Excel  Gerry Resch 714-772-6667  gerry@gerryresch.com 
GPS Navigation Bob DeWolf 714-879-8269  rsdewolf@adelphia.net 
Linux Bob Ray 714-634-7520  bobsdesk@dialup4less.com 
Lotus 1-2-3 Gerry Resch 714-772-6667  gerry@gerryresch.com 
Memory/Interrupts Martin LaRocque 562-697-4318  6 - 9 p.m. 
Microsoft Office John Heenan 714-998-7660  heenanjc@sbcglobal.net 
PC Hardware Jim Sanders 714-544-3589  jsandes@ligasmicro.com 
Photo editing & Pshop Larry Klees 714-879-6405  larryklees@yahoo.com 
QuickBooks - all ver. Linda Russell 909-949-4930  qbqueen@verizon.net 
Tcl/Tk & UNIX Bob DeWolf 714-879-8269  rsdewolf@adelphia.net 
Windows 7, Vista & XP Jim Sanders 714-544-3589  jsanders@ligasmicro.com 
Windows 9X & XP John Heenan 714-998-7660  heenanjc@sbcglobal.net 
WiFi & Networking Jim Sanders 714-544-3589  jsanders@ligasmicro.com 
 

Do you want to be an NOCCC Help Volunteer and assist other members with computing subjects that you know well?  
If so, please contact Ted Littman at tedlit@roadrunner.com or (714) 779-1936. 
 

Contact the SIG leaders by e-mail, preferably, rather than by telephone. 

 SIG BLDG RM. TIME LEADER E-MAIL PHONE  
Linux for Desktop/Admin……….Science……131         9:00/10:30 ...........Bob Ray...........................  bobrobo@dialup4less.com (714) 634-7520 
Beginner’s Digital Photography Science…….127………....9:00………….John Krill.....……………     noccc.bgphotosig@gmail.com   (949) 497-8658 
Visual Programming Science........ 111..............9:00 ...............Anson Chapman…………  aeccrcss@hotmail.com             (909) 860-9515 
Word, Excel and Outlook Science........ 109..............9:00 ...............Tia Christian ....................  lwilliams_00@yahoo.com (714) 263-6105 
Access Science........ 306..............9:00 ...............Bob Dickson ....................  robertbdickson@socal.rr.com (714) 539-1304 
Advanced Digital Photography Science........ 127   .........10:30 ...............Larry Klees ......................  larryklees@yahoo.com  (714) 879-6405 
Understanding OS’s Science........ 111............10:30 ...............Charlie Moore..................  mooreca@roadrunner.com (714) 529-9071 
Access VBA                          .   Science …….306………..10:30.………….Bob Dickson……………   robertbdickson@socal.rr.com (714) 539-1304 
PC Q&A Irvine Hall…………10:30/12:30 ...............Jim Sanders ....................  jsanders@ligasmicro.com (714) 544-3589 
   
 
 Please report SIG changes to Ted Littman, editor@noccc.org, or (714) 779-1936. 

 
 
 
 

SIG Leaders  

The names of our 
volunteers are 
only available in 
the printed 
version of the 
Orange Bytes. 

NOCCC Help Volunteers 
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Computer Talk 
 

Excel Tips 
(Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by 
permission. Thousands of free Microsoft Excel tips can be found 
online at http://excel.tips.net.) 
 
Locked File Puzzle 
Eric was having a problem with one of his workbooks. It seems 
that every time he opened the workbook he saw a dialog box 
that said the file was locked and that he would have to save 
changes under a different name. Even when he does that, the 
dialog box still appears on the new workbook. 

The first thing to try is to restart your machine, or copy the 
workbook to a different folder on your system. The reasoning 
for this is simple: Sometimes Excel can get confused and think 
that a file is "locked" by another user, when in fact it is not. 
Restarting or copying the workbook can help clear the 
confusion. 

The most likely cause of this problem, however, is that there is 
some sort of macro running when the workbook is opened. Even 
if you save the workbook under a different name, the macro 
would be saved with the new workbook, and the process would 
repeat itself all over again. To test this, try the following: 

1. Open the workbook like normal, dismissing the dialog 
box. 

2. Select all the worksheets in the workbook. (Click on 
the left-most worksheet, then hold down the Shift key 
as you click on the right-most worksheet.) 

3. Choose Move or Copy Sheet from the Edit menu. 
Excel displays the Move or Copy dialog box. (To 
display the proper dialog box in Excel 2007, display 
the Home tab of the ribbon. Click the Format tool in 
the Cells group, and then select Move or Copy Sheet 
from the resulting submenu.) (Click here to see a 
related figure.)  

4. Using the To Book drop-down list, choose (new book). 
5. Make sure the Create a Copy check box is selected. 
6. Click OK. 

Now you have two workbooks: the one you opened and a new, 
unnamed workbook. Close the original workbook without 
saving, and then save the new workbook under any name 
desired. You should be able to open the new workbook with no 
problems, as macros are not copied in the above steps. 

If you cannot complete step 3 because the Move or Copy Sheet 
option is not available, it means that the worksheets have been 
protected. You would need to remove protection from the 
worksheets before you could copy them. 

Pick ing  a  Cont iguous  Range  o f  Ce l l s  

There are many times when you are working with Excel when 
you need to select a range of cells. This is very easy to do using 
either the keyboard, the mouse, or a combination of both. 

The first step in selecting a range of cells is to select the first 
cell in the range. With the cell selected you are ready to 
proceed. 

• Using the keyboard, you can hold down the Shift key 
as you use the navigation keys (up, down, left, and 
right arrows) to extend the range. 

• Using the mouse, you can click on the first cell and 
hold down the mouse button as you drag the mouse to 
extend the range. 

• Using the keyboard and mouse, you can hold down the 
Shift key as you click on the cell that defines the 
opposite corner of the range you want selected. 

Retaining Formatting After a Paste 
Multiply 
One of the really cool features of Excel is the many ways you 
can manipulate data using the Paste Special command. This 
command allows you to do all sorts of things to you data, as you 
paste it into a worksheet. One such manipulation you can 
perform is to multiply data as you paste. For instance, you can 
multiply all the values being pasted by -1, thereby converting 
them into negative numbers. To do so, follow these steps: 

1. Place the value -1 in an unused cell of your worksheet. 
2. Select the value and press Ctrl+C. Excel copies the 

value (-1) to the Clipboard. 
3. Select the range of cells that you want to multiply by -

1. 

http://excel.tips.net


 

8 Orange Bytes 

4. Display the Paste Special dialog box. In versions of 
Excel prior to Excel 2007 you do this by choosing 
Paste Special from the Edit menu. In Excel 2007 you 
display the Home tab of the ribbon, click the down-
arrow under the Paste tool, and then click Paste 
Special. 

5. Click on the Multiply radio button. 
6. Click on OK. 

At this point Excel multiplies the values in the selected cells by 
the value in the Clipboard. Unfortunately, if the cells in the 
selected range had special formatting, the formatting is also now 
gone, and the format of the cells is set to be the same as the cell 
you selected in step 2. 

To make sure that the formatting of the target cells is not 
changed while doing the Paste Special, there is one other option 
you need to select in the Paste Special dialog box—Values. In 
other words, you would still select Multiply (as in step 5), but 
you would also select Values before clicking on OK. 

With the Values radio button selected, Excel only operates on 
the values in the cells, and leaves the formatting of the target 
range unchanged. 

Adding Diagonal Borders 
Excel allows you to add all sorts of borders to cells in a 
worksheet. You can place borders on the left, right, top, and 
bottom of a cell. If you select a range of cells, you can add 
borders to the left, right, top, bottom, and in between, meaning 
that the borders could be between cells within the selected 
range. 

Many people don't realize that you can also place diagonal 
borders. This means that a border can appear from the top-left to 
the lower-right corners of a cell, or from the top-right to the 
lower-left. To take advantage of diagonal borders, follow these 
steps: 

1. Select the cell you want to have the diagonal border. 

2. Choose Cells from the Format menu. Excel displays 
the Format Cells dialog box. (To display the dialog box 
in Excel 2007, display the Home tab of the ribbon, 
click Format in the Cells group, and then choose 
Format Cells.) 

3. Make sure the Border tab is selected. At the bottom left 
and right corners of the Preview area of the dialog box 
you should see buttons that have diagonal lines on 
them. Click the line that represents the type of diagonal 
border you want to use. 

4. Click on OK. 

Diagonal borders can only be applied to cells, not to rectangular 
areas you select onscreen. For instance, if you choose cells 
A5:C12, the diagonal border won't go from the top-left corner of 
cell A5 to the bottom-right corner of cell C12. Instead, it is 
applied to the individual cells within the selected range. 

Adding Page Numbers 
If you are creating spreadsheets that are more than a page or two 
in length, you will probably want to include page numbers so 
you can keep your pages in order when you make a printout. 
Excel supports automatic numbering of pages in your 
spreadsheet, and you can control the type of page number, the 
starting number, and the placement of the page number. To add 
page numbers, follow these steps: 

1. Since page numbers are placed in headers or footers, 
select Page Setup from the File menu. This displays the 
Page Setup dialog box. 

2. Make sure the Header/Footer tab is selected. (Click 
here to see a related figure.)  

3. Click on either Custom Header or Custom Footer, 
depending on where you want the page number to 
appear. This displays either the Header or Footer dialog 
box. (Click here to see a related figure.)  

4. Position the insertion point in the Left, Center, or Right 
box, depending on where in the header or footer you 
want the page number placed. 

5. Click on the page number tool (it looks like a piece of 
paper with a number sign in the center of it). This 
places the characters &[Page] at the insertion point. 
This is where the page number will be located. 

6. Click on OK to close the Header or Footer dialog box. 
7. Click on OK to close the Page Setup dialog box. 

Indenting Cell  Contents 
Excel allows you to format the contents of a cell in a myriad of 
ways. One of the formatting options you can apply is to indent 
the contents of a cell by a certain amount. This is similar to 
indenting done in a word processor, such as Microsoft Word, 
except that the indenting is specified in a number of characters, 
not in a linear distance such as inches or points. 

To set the indent to be used in a cell, follow these steps: 

1. Select the cells you want to format. 



April  2011 9 

2. Choose Cells from the Format menu. Excel displays 
the Format Cells dialog box. 

3. Make sure the Alignment tab is selected.  In the 
Horizontal drop-down list, choose Left (Indent). If you 
are using Excel 2002 or 2003, you can also choose 
Right (Indent). 

4. Using the Indent control, specify the number of 

characters by which the cell contents should be 
indented from either the left or right side of the cell. 
You can pick any whole number between 0 and 15. 

5. Click on OK. 

Note in step 4 that you can choose either a left or right indent if 
you are using Excel 2002 or Excel 2003. You cannot, however, 
indent from both the left and right, like you can with a word 
processor. You can only choose to indent from the left or the 
right. 

Inserting a Row or Column 
Inserting a blank row or column in your worksheet (between 
two rows or columns currently in use) is very easy in Excel. All 
you need to do is select the row or column that you want the 
new row or column to appear before. You then need to choose 
Columns from the Insert menu (to insert a column) or Rows 
from the Insert menu (to insert a row). Excel adjusts your 
worksheet so the new column or row appears as directed. 

If you prefer to not use the menus or the mouse, you can use a 
keyboard shortcut to insert a row or column. All you need to do 
is select the row or column that you want the new row or 
column to appear before. Then, press Ctrl++ (that's Ctrl and the 
plus sign at the same time). Excel adjusts your worksheet so the 
new column or row appears as directed. 

 
 

Changing Page Margins 
When you first start Excel, certain assumptions are made about 
your page layout. One of these assumptions has to do with your 
page margins. You can change your page margins at any time 
by following these steps: 

1. Choose the Page Setup option from the File menu. You 
will see the Page Setup dialog box. 

2. Make sure the Margins tab is selected.  
3. Adjust the top, bottom, left, and right margins as 

desired. 
4. Click on OK. 

Word Tips 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted by 
permission. Thousands of free Microsoft Word tips can be found 
online at http://word.tips.net. 

 
Embedding Fonts in a Document 
The fonts you use in a document determine exactly how that 
document appears when viewed or printed. If you are sharing 
your documents with others, you will want to make sure that 
they have the same fonts you used in the document. If they 
don't, then they may not be able to read the information you 
send. 

Why is this? If you use a particular font in a document, then 
send that document to another person who does not have that 
font on their system, Word tries to figure out what font it can 
use as a substitute for the font you used. In some cases, the 
results are an unreadable mess with symbols being substituted 
for characters and vice-versa. Even if the substituted font results 
in a readable document, your precise formatting may no longer 
apply since Word uses the character widths and sizing of the 
substituted font, not the original. Thus, text will flow differently 
on the target system and lines or pages will not break at the 
same place as originally intended. 

Word does provide a potential solution to this mess: you can 
embed fonts in a document. Word allows you to embed fonts in 
your document, with a couple of caveats. First of all, the fonts 
must be TrueType fonts, and second, they must be available for 
embedding. Figuring out if a font is TrueType is easy enough—
you can take a look at the Windows Font folder to figure that 
out, or you can simply look for the telltale TT next to the font 
name in Word's Font drop-down list. 

Figuring out if a font is embeddable is another issue. When a 
font is created, by the designer, it can be set to one of four levels 
of embedding compatibility: 

• Fully Embeddable. These will embed in the document 
and install themselves on the target system if they do 
not already exist there. 

http://word.tips.net
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• Editable Embedding. The document is editable in the 
embedded font, but will not permanently install on the 
target system. 

• Print and Preview Only. The document will print 
with the correct font on the target system, but it is not 
editable and the font will not install. 

• Not Embeddable. The font stays on the original 
system and cannot be embedded in a document. 

Word respects the wishes of the font designer, according to the 
possible settings show here. If a designer marks a font as "not 
embeddable," then you cannot embed it in a document. More 
precisely, you can instruct Word to embed TrueType fonts, but 
Word ignores your instruction when it comes to the font that is 
marked as not embeddable. 

So how do you find out if a font is embeddable? There is no 
way to do so without a special tool that will read the font, 
examine the instructions of the designer in this regard, and then 
inform you of them. Such a tool is available for free from 
Microsoft. This tool is for use with Windows 95 or later; you 
can download it from the following address: 

http://www.microsoft.com/typography/TrueTypeProperty21.mspx 

The tool updates Windows so it displays more information when 
you right-click on a font file and choose Properties. One of the 
tabs displayed in the resulting dialog box contains information 
on how a font can be embedded in a Word document. 

If a font is not embeddable, then you are faced with a decision: 
whether to use the font or not. If you do use it, then the 
document will only display properly on systems where the font 
is really installed. If you don't use it, then you will need to find a 
different font that meets your design and sharing needs. 

Once you know that a font can be embedded in a document, you 
need to instruct Word to do the actual embedding. You do this 
by following these steps: 

1. Choose Options from the Tools menu. Word displays 
the Options dialog box. 

2. Make sure the Save tab is selected.  Ensure the Embed 
TrueType Fonts check box is selected. 

3. If you will be using a small number of characters in a 
particular font, choose the Embed Characters In Use 
Only check box. (This check box is available only in 
Word 97 or later versions.) 

4. Click on OK. 
5. Work with your documents as normal. 

You should know that when you embed a font, the size of your 
document can be significantly increased. If you don't choose the 
check box in step 4, then Word embeds the entire font. In either 
case (full font or just characters), the size of your document is 
increased by the size of the font being embedded, plus some 
overhead required by Word. 

There is one "gottcha" when embedding fonts in a document. If 
you are using Word 2002, and you save your documents in RTF 
format instead of native DOC format, Word may not embed a 
font properly in the document. The solution, as described in 
Knowledge Base article Q275953, is to make sure that you save 
the document in DOC format, not RTF format. 

Using Different Shapes in WordArt 
WordArt is a program that allows you to treat text as a graphic. 
You can use the program to add special effects and flourishes to 
text and then insert the text in your document. One of the special 
effects areas is implemented through different shapes you can 
apply to your text. You apply shapes in the following manner: 

1. Select the WordArt object by clicking on it. Word 
displays the WordArt toolbar. 

2. Click on the WordArt Shape tool. A graphic menu of 
forty different shapes appears. 

3. Select the shape you want to use. WordArt updates 
your WordArt object. 

You should note that the WordArt shapes are different than 
what you selected in the WordArt Gallery. Each affects the 
other, and you may need to do some experimentation to get 
exactly the effect you desire. 

 

http://www.microsoft.com/typography/TrueTypeProperty21.mspx
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Products Available for Review 
he NOCCC regularly receives 
copies of books and software 
from vendors for our review.  

We can also request specific 
products for you to review.  These 
reviews are published in this 
newsletter, the Orange Bytes.    
Then, you get to keep the book or 
software.  If you are interested in 
doing a review, please call or send 
me an e-mail and provide your 
membership number, phone number, 
and e-mail address. You can pick up 
the product in the lobby of Irvine 
Hall between 9 A.M. and Noon at the next NOCCC meeting. 
 
Ted Littman, (714) 779-1936, reviews@noccc.org. 

Note to Reviewers 

 You have 2 months to submit a review. Due-cause time 
extensions must be requested from the Reviews Editor. 

 You must leave a security deposit (check, credit card 
number, or cash equal to the product’s list value.), 
returnable upon our receiving an acceptable review. 

 If you decide to return the product without reviewing, 
there is a $2 penalty after the first month and a $5 
penalty after the second month. 

 Guidelines for preparing your review are addressed on 
the next page.   

 

Boxed Programs and CDs  
 
Photoshop CS4 for Windows – Top of the line photo editing 
program with all the bells & whistles from Adobe. $727 on 
Amazon.com. (Latest version is CS5.) 
Vipre Antivirus Premium 4 – A high-performance antivirus + 
antispyware software with an integrated firewall. And it isn’t 
bloated! From Sunbelt Software. MSRP=$40. 
Norton Internet Security 2011 – Symantec’s premier 
protection suite for viruses, spyware, spam. MSRP=$70. 
Norton Utilities – Symantec’s PC optimization suite. 
MSRP=$50. 
SnagIt 9.1 – The premier screen-capture utility with lots of 
“bells-and-whistles” for every computerist level. From 
TechSmith. MSRP=$50.  

Books 
Technology 
Technology at the Margins – A must-read book for 
technologists who want to leverage the power of IT. From 
Wiley. MSRP=$40. 

Office & Home Programs 
New: Microsoft Office 2010 All-in-One for Dummies – Get 
up to speed on all the applications (Word, Outlook, PowerPoint, 
Excel, Access, Publisher, & Common Office Tools). From 
Wiley. MSRP=$35. 
New: Microsoft Access 2010 Programmer’s Reference – This 
1200-page reference book tells you everything you need to 
know about the latest Access database program. MSRP=$45. 
Internet 
None. 
Digital Photography & Design 
New: Canon PowerShot G12 – From snapshots to great shots 
by Jeff Carlson from Peachpit Press. MSRP=$25. 
New: The Photoshop Elements 9 Book for Digital 
Photographers – New Riders book by Scott Kelby & Matt 
Kloskowski.MSRP=$50. 
New: Layers – The Complete Guide to Photoshop’s Most 
Powerful Features – The one thing that makes Photoshop so 
amazing. By Matt Kloskowski from Peachpit Press. MSRP=$45 
New: Adobe Real World Photoshop CS5 for Photographers 
– From Peachpit Press, MSRP=$60. 
New: Adobe InDesign CS5 Classroon in a Book – The official 
training workbook from Adobe Systems. Includes a CD. From 
AdobePress. MSRP=$55. 
Real World InDesign CS4 – This book covers the waterfront 
on Adobe’s new design suite. Authored by Olav Kvorn & David 
Blatner, it is published by Peachpit Press. MSRP=$55. 
Security 
None. 
 

Preparing a Review or Article for 
the NOCCC Orange Bytes 

By Steven Breitbart, NOCCC 

here are two sections in the NOCCC newsletter, the 
Orange Bytes, where our members can contribute 
reviews and articles.  They are the Computer Talk 

section and the Product Reviews section. 

Articles in the Computer Talk section can be about almost any 
computer or technology related experience that you have had.  
For example, getting a new ISP, getting an ISP to change your 
connection speed, converting a PC to Linux, using a MacIntosh 
PC for the first time - the list is endless. 
The Product Reviews section can be a review of almost any 
type of computer hardware, software, or book about a computer- 
related topic.  The item can be something you have bought or 
obtained from the NOCCC.  Once you agree to do a review, you 
will generally have 2 months to complete it.  These reviews are 
published in this newsletter, the Orange Bytes. 

Continued on page 26 
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Product Reviews 
Windows Lab - The Start Menu for Windows 7 

 
By Barney Babin, Cajun Clickers Computer Club (LA) 
member and instructor for XP, Vista Workshop and Windows 
7 January 2010 issue, Cajun Clickers Computer News 
www.clickers.org; ccnewsletter (at) cox.net 
 

very iteration of Microsoft’s Operating System since XP 
has had a Start Menu that  functions basically the same; but 

Windows 7 has many distinctly different features that make it 
stand apart from the others. For example, when you open the 
Start Menu, your curser is automatically positioned in the 
“Search Programs and files” area (Fig. 1), just as in Vista, and is 
waiting for you to type something there. If you have no clue 
where  something is located, or how to navigate to a specific 
place in your computer, type it into this area. As you start typing 
the item you are looking for, the search results will appear. 
When you see your item, stop typing, click it (fig. 2), and it will 
appear on your screen (Fig. 3). 

I chose the item Getting Started to search for on purpose. As 
seen in Fig. 3, there are six  items  that can be double clicked for  
more useful information about that topic. For those of you who 
are new to Windows 7, I strongly urge you to look at these  
categories to glean a lot of useful information. If you notice the 
address window at the top of the  item or the category where the 
item was  listed on the search results, it can be found in the 
Control Panel, but since you searched on the item and opened it 
from search, knowing that this item exists in Control Panel is 
not necessary. 
 

I also recommend that you click Control Panel and look at the 
various items listed there. You will soon discover that some of 
the items have changed names from previous  
versions of the Microsoft Operating Systems. For example, 
Add/Remove Programs in XP is now called Programs and 
Features. The functionality is basically the same; just the item 
name has changed. 
 
Another new item in Windows 7 is the Action Center (Fig. 4), 
which can be found either in Control Panel, via the start menu 
search feature, or double clicking the white flag  in  
the icons just to the left of  the clock. In action center, you will 

find many things that are very useful such as Backup and 
Restore, User Accounts, Security, and maintenance; but as you 
have probably guessed by now, you can also access all of these 
items via  the Start Menu search function. 
 

E 

http://www.clickers.org
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You can also use the search function to search for words, 
phrases, titles, etc. of documents and access items in your search 
results directly from  there.  
 

 
Tips & Tricks – Slip an Ace Up Your Sleeve 

 
By Bob Goodman, Newsletter Team, Cajun Clickers Computer 
Club, LA, January 2011issue, Cajun Clickers Computer News 
www.clickers.org, bob (at) houseplanz.com 
 
emailSTRIPPER 
 
emailSTRIPPER is a free program for cleaning the ">", 
unwanted  carriage  returns,  and  other  formatting characters  
out  of  your  emails.  It will restore "forwarded" or "replied" 
emails back to their original state so they’re easier to read. It’s 
simple to use, and best of all it’s FREE! 
http://www.papercut.com/emailStripper.htm 
 
3 PC Problems You Can Fix 
 
Ever notice how your PC has multiple personalities? In the 
course of a week, your computer may act friendly, moody, and 
sometimes downright mean. However, don't take a hammer to 
your PC just yet. The following is a list of common symptoms 
and treatments to help even the most troublesome PCs. You 
don't even have to be a psychologist (at least not yet) to deal 
with your PC's neuroses. Windows 7 and Windows Vista 
usually manage this automatically, but overall you'll find that 
these tips work for all versions of Windows, from Windows 95 
to Windows 7: http://tinyurl.com/y8m8en6 .  
 
Salvage a Wet Mobile Phone 
www.wikihow.com/Save-a-Wet-Cell-Phone 
 
If you drop your mobile phone in water or get it wet in a heavy 
rain; don't panic; it's possible to save it. Consider these easy,  
simple  steps: 
 

1. Act rapidly: First, quickly  remove all covers and 
as many detachable parts as  
possible, such as the back cover, battery, SIM 
card, memory card etc. Next, take a piece of cloth 
or tissue paper and absorb as much excess water as 
possible. Make sure to dry it completely, before 
water soaks into difficult to reach places. If your 
phone was under water for just a short time, this 
quick drying procedure alone might save it. 

2. Use a hair-dryer: Then, use a hair-dryer to 
thoroughly dry the phone and  
components; but don't hold it too close to the 
phone, as that may harm the electrical 
mechanisms. Pay extra attention to the battery 
area. The battery housing usually consists of tiny 
holes to let air (and consequently, water) into the 
phone. If steps #1 & #2 fail, then continue to step 
#3. 

3. Drying for long duration: Place the disassembled 
phone and parts in a dry,  

warm place and allow the water to evaporate 
gradually. 

 
Also see: www.wikihow.com/Save-a-Wet-Cell-Phone 
 
How to Secure a Wireless Network 
 
We secure a wireless network to stop people without permission 
from using it. It’s harder to secure a wireless network than a 
classic wired network. This is due to the fact that a wireless 
network can be accessed from anywhere inside the range of its 
antenna. 
 
If  you  don't  secure  a  wireless network  from hackers, you 
might  lose the service, or your network could be used  to  attack  
other  networks.  To secure  a  wireless  network  from hackers,  
just  follow  these  simple  tips: 
 

1. Strategic antenna placement: Position the access point's 
antenna in a place which restricts the range of its signal 
to go further than the required area. Do not place the 
antenna next to a window, but in a central location of 
the building. 

2. Use WEP: WEP stands for Wireless Encryption 
Protocol. It's a customary technique for encrypting 
traffic on a wireless network to block access by 
hackers. 

3. Change the SSID, disable broadcast of SSID: SSID 
stands for Service Set Identifier. It is the recognition 
thread utilized by the wireless access point to  
allow authorized users to open connections. For every 
wireless access point arranged, select an exclusive and 
unique SSID. Also, disallow the broadcast of the SSID. 
Services will be provided as usual, but the SSID will 
not appear in the listing of offered networks. 

4. Disable DHCP: By doing this, the hackers will have to 
decode the TCP/IP parameters, subnet mask, and IP 
address in order to hack your wireless network. 

5. Disable or modify SNMP settings: Change the private 
as well as public community settings of SNMP. You 
can also just disable it. Otherwise the hackers will be 
able to utilize SNMP to get significant info regarding 
your wireless network. 

6. Utilize access lists: For additional security of your 
wireless network, if your access point supports this 
feature, employ an access list. An access list lets you 
determine precisely which computers are permitted to 
access your network. Access points which use access 
lists can employ Trivial File Transfer Protocol (TFTP) 
in order to download updated lists periodically and 
steer clear of hackers. See page:  
http://tinyurl.com/28tz3lg 

 
 
 

If I had only known (the future), I would have 
been a locksmith. 

 
Albert Einstein 

http://www.clickers.org
http://www.papercut.com/emailStripper.htm
http://tinyurl.com/y8m8en6
http://www.wikihow.com/Save-a-Wet-Cell-Phone
http://www.wikihow.com/Save-a-Wet-Cell-Phone
http://tinyurl.com/28tz3lg
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March 6, 2011  
Main Meeting Report 

By Steven Breitbart, NOCCC 
Photos by John Krill 
 
Club Business 

OCCC President Jim Sanders opened the meeting.  He 
reminded us that the club was 35 years old.  He once 
again expressed the club’s get-well wishes for Ted 

Littman’s wife, Sylvia.  He mentioned that Ted is the Reviews 
Editor, club Secretary, our Publication Chairman, and Editor of 
the Orange Bytes.  Since Ted may not be able to make it in the 
near future, we are looking for people to help run the Reviews 
Table at the regular NOCCC meetings.   

The Vice President’s position is also open since Bob Dickson 
had to leave that position some months ago, also because of his 
wife’s illness.  Bob is still participating in the club, leading the 
Access VBA and Access SIGs. 

Main Meeting Topic 

Mitch Siegel (www.ninedotmarketing.com/about-us), founder 
of Nine Dot Marketing, based in Irvine, California, gave us a 
presentation about Social Networking.  While most of the 
presentation was about the business applications of Social 
Media sites such as Facebook, Twitter, and LinkedIn, he 
provided a lot of other information as well. 

Mitch said he was not a “techie;” his wife creates his web site 
and blog.  He has bridged the gap between advertising that was 
in newspapers and magazines and is now in many places.  The 
difference is that today there are a lot more sources for 
information; we are not just listening to trusted broadcasters and 
reading our local newspapers any more.  People are now 
developing and reporting their own news. 

Social networks have influenced world events in that they have 
speeded up the flow of information to an unimaginable degree.  
For example, 470,000 people followed the Facebook page 
(www.facebook.com/elshaheeed.co.uk) dedicated to Khaled 
Said, an Egyptian man killed by Egyptian police.  500,000 have 
viewed the YouTube video about him.  While Facebook did not 

cause the removal of former President Hosni Mubarak, it made 
it happen quicker; the “revolution” took 18 days and then he left 
the country.  United States President Barak Obama has also 
credited social media with helping him get elected.  Mitch said 
that it will be a factor in every election from now on. 

He also warned us to be careful what you say or write in social 
media.  An assistant attorney general in Indiana tweeted that 
police should use live ammunition against the pro-labor 
protestors in Wisconsin and as a result, he lost his job. 

Networking is not selling, whether in person or using social 
networking sites.  Using social networking sites for blatant 
attempts at sales is not accepted.  However, it is acceptable to 
refer people to a web site where you can have your items or 
services for sale. 

Mitch gave us some guidelines for using social media and 
information on what it can be used for, but the three areas of 
networking still apply to social networks: planning, etiquette, 
and follow-up.   

Using social media for networking is an extension of, not a 
replacement of, personal networking.  The goals are similar: 
communicating and informing people about what you can do or 
what you need, developing contacts, and sharing information.  
You can use social media to get people together that have 
similar needs.  He recommended noting personal details about 
people such as family members or recent events in order to 
make conversations, regardless of media, more personal.  
Personal information also helps you remember people.  Try to 
be a resource for other people so, over time, you become the 
“go-to” person when someone needs help. 

Social Media can also be used to build an image, increase your 
visibility and build and tighten your relationships with your 
contacts.  Mitch recommends encouraging feedback which will 
aid in website optimization, that is, the more traffic you have 
going to your web site, the better.  A short video mentioned that 
social media lets you see connections that have been hidden up 
till now.  That is, you can see friends of your friends and 
relatively easily make contact with them. 

When using social networks, remember to respect differences 
between people and be open minded.  Excluding someone based 
on their beliefs, race, etc. can eliminate opportunities because 
you don’t just exclude that one person; you exclude all the 
people in their network. 

There are several aspects of social networking that can be a 
problem.  Requests for connections to you or to your 
connections may be spam.  Other security issues are that viruses 
and malware may be getting into your computers from unknown 
people.  He strongly recommended a firewall and anti-virus 
software. 

Other concerns are the lack of privacy and the amount of time 
participating in social networking can consume.  He is 
concerned that people being too transparent online may backfire 
on society.  Remedies include keeping up with the security 
settings and are keeping a separate account for your personal 
life and another for business purposes.  When using the social 
networks, have an agenda or goal, or set aside a block of time to 
do what you need to do.  Mitch maintains less than 200 
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LinkedIn connections with people with whom he has contact.  
He recommended not having too many connections because a 
large number of them would be too hard to manage.  Still, 
through those connections, he has access to over 80,000 people 
at the next level, then 5.8 million people at the third level. 

Mitch said he has noticed that people are becoming ruder; there 
are so many ways of communicating that people don’t have time 
to respond to every message.  He recommended responding to 
requests for connections and friends that you don’t want with 
something similar to “I’ve made the decision to not spend a lot 
of time on Facebook.” 

When addressing your presence on Facebook, LinkedIn or your 
blog, you need to set the content expectations and decide how 
much information you are going to provide.  RSS feeds (Really 
Simple Syndication) are another way to get information on 
things you are interested in.  By all means, track and analyze 
what you are doing.  Find out what pays off for you and what is 
enjoyable for you. 

Mitch provided details about LinkedIn, Facebook, blogs and 
Twitter.  There are tutorials or online help available online.  
Both Facebook and LinkedIn allow people and companies to 
conduct polls, focus groups and contests very cheaply.  You can 
post photos, videos or examples of your work on one or both of 
these sites. 

LinkedIn was launched in May 2003 and now has over 90 
million users.  It is free to a point, but there is higher level of 
messaging which can be purchased.  Mitch uses the free service 
and gets the connections he needs through people he already 
knows.  The LinkedIn profile is actually unique in that it may 
take months to complete.  To get to 100% completion, you must 
have three people recommend you.  Mitch’s profile describes 
his company, Nine Dot Marketing, his education and the 
number of recommendations and connections he has.  You can 
get updates on your connections which lists the new connections 
they have made.  Groups with LinkedIn allow you to contact a 
whole industry, but joining one doesn’t give you a personal 
connection with everyone.  Joining a group and staying active 
does get you a higher priority for some aspects of LinkedIn.  
Mitch recommended getting on the Board for one group that 
you join. 

Many companies also have LinkedIn sites.  You can search 
companies and industries and find out who the key people are.  
People searches are also possible.  Mitch spends less than one 
hour per week on LinkedIn and recommends that we should all 
join.  In general, though, using the social networks has become 
part of his lifestyle, so he sets aside time for it. 

Facebook is, of course, very popular.  It provides a way to build 
a community and keep in touch with all your friends very easily.  
Communication can be one-to-one, or friends can see what you 
are posting to other friends. 

Blogs are a good source of knowledge and a way to express 
yourself.  Mitch said he started a blog about six months ago.  He 
works on his blog on Monday, so the messages are delivered on 
Tuesday.  The messages are sent to LinkedIn, Twitter and 
Facebook, so all people who follow him can see them.  The 
messages link to specific pages in his web site that provides 
details on the message topic.  In general, these are short 

messages of not more than 300 words.  He has broken up a 
longer message into parts, delivered over several weeks.  His 
messages are usually related to sales and marketing, such as the 
commercials in the Super Bowl. 

The details you must decide when starting a blog are similar to 
what you do when setting up a web site.  You need a domain, 
and TO choose blogging software.  Mitch uses Drupal, but said 
that Wordpress is the easiest to use.   You also need to create a 
masthead, decide on a theme and who your intended audience 
is, and if you will allow subscriptions to the blog.  The name of 
the blog and titles in the blog should be tied to something on 
your web site.  Register the blog in a directory with key words 
that describe the blog 

A blog message can be a comment on another blog.  Mitch did 
this at one point and the other blogger was a V.P. of Marketing 
who later contacted him.  As a result, Mitch was able to get a 
speaker for a group he was in. 

Twitter type communication is called a micro-blog.  Even 
though the messages, called tweets, have a 140 character 
maximum, they are having an influence on mass media.  Mitch 
described a situation where people on CNN were talking about 
the official unemployment rates, but found out the number of 
unemployed people is higher because of tweets from people 
who are no longer eligible to collect unemployment insurance. 

Even for Twitter, Mitch said to define you profile and goals and 
to target your tweets.  This is a good way to generate 
discussions and make yourself known to CEOs of companies.  
However, don’t include blatant sales messages in a tweet. 

The bottom line is that you want to be on the first page of results 
from a search engine.  When accomplished, by having a 
presence on Facebook, LinkedIn, Twitter or a blog and by doing 
search engine optimization, a smaller company can compete 
with larger companies. 

Other resources that might be useful for social networking 
online are Inthecalendar.com (no www), which used to be called 
MeetingsandMixers.com.  Information on online conduct is 
available at www.albion.com/nettiquette. 

The final few pieces of advice Mitch gave us was “Remember 
the three Bs: Be honest, be consistent and be positive.”  
Consistent means providing the same information about yourself 
from one site to another, so you’re believable.  Follow-up; find 
out what type of communication a person wants.  Some want 
email, others want text messages or phone calls.  Also, respond 
24 to 48 hours after a contact has been made. 
 

Another interesting meeting.  See you all next month. 

If you are an NOCCC member and you would like to give a 
presentation about something interesting you have done with 
your computer, speak to one of the Board Members.  And, if 
the topic is not long enough for the Main meeting, perhaps 
you could deliver it during one of our SIG meetings. 
 

NOCCC meeting attendees please note that Chapman 
University prohibits food and beverages in Irvine Hall and its 
other auditoriums. 

http://www.albion.com/nettiquette
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March 6, 2011 Raffle Winners 
 

Photos by John Krill, NOCCC 

Your photo could be here, but only if you buy a raffle ticket. 
 $1 per ticket or 6 tickets for $5! 
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SIG Meeting Reports 
Beginner’s Digital Photography  

By John Krill, SIG Leader 
 
Taking Really Nice Photos 
 

he Rule of Thirds is applied by 
aligning a subject with the guide 
lines and their intersection 

points, placing the horizon on the top or 
bottom line, or allowing linear features 
in the image to flow from section to 
section. The main reason for observing 
the rule of thirds is to discourage 
placement of the subject at the center, or 
prevent a horizon from appearing to 
divide the picture in half. 
 
Getting consistent photos requires only a few basic ideas. The 
most important of these is the ‘Rule of Thirds.’ We took a look 
at a short video on YouTube that explains the basics of this rule. 
The video is at: 
http://www.youtube.com/watch?v=ENHKjb8ltAM.  
 
You can also search YouTube for: Rule of Thirds. The one I 
showed was called: Composition Rule 3 - The Rule of Thirds. 
 
Check out Wikipedia’s page on the Rule of Thirds: 
http://en.wikipedia.org/wiki/Rule_of_thirds. 
 
Basic Editing Tools Using Adobe Photoshop Elements 
 
I personally use very few of the total tools available with 
Elements. My primary tools are the Leveling tool, and the 
Cropping tool. The Cropping tool allows you to crop your image 
using three different methods: Normal, Fixed Ratio, and Fixed 
Size. Once you crop your image you then need to resize it for 
your requirements.  
 
But there is an easier way. 
 
Quick and Easy Way to Resize Your Image for Printing 
 
Another method to crop and resize your image for printing is to 
use the Aspect Ratio tool. With this tool you can crop and resize 
to the exact size you need for printing. There are several presets 
but you can also use your own custom sizes. For instance I use 8 
inches by 10.5 inches to print on 8.5 x 11 inch paper. You can 
also switch between Landscape and Portrait mode by just 
double-clicking the double arrow icon in the tools menu bar. 
 
I will demonstrate the Aspect Ration tool at the April meeting. 
 
The Magic Command 
 
Never forget the Undo or Control Z command. With this 
command, you can back off your changes you made One-Edit-
At-A-Time starting with the most recent.  
Creating a Calendar Using Shutterfly 

Finally, we created a calendar using the online service 
Shutterfly. We started by uploading the images we wanted to 
use and ended by saving the completed calendar. It cost nothing 
but your time and effort to make the calendar. Only when you 
order a calendar will money be involved. 
 
It should be noted that you can delete all your images once you 
have completed making your calendar. You can also use the 
same images on any other project you do at Shutterfly. 
 
April Meeting 
 
I will continue to show ways to make good photos. I will show 
examples of the Aspect Ratio tool. And finally we will look at 
online options for storing and sharing your photos. 
 
Bring Your Camera 
 
Bring your camera to the meeting. We just may go outside and 
practice the stuff we learned in the classroom. I don’t care what 
kind of camera you have; just bring it! 
 
Questions 
 
I know you have them. Bring them to the next meeting. We all 
start not knowing what we’re doing. So don’t worry about it. 
Ask and you shall be rewarded. I promise. Photography is fun. 
The more you know the more fun it is. 
 
Standard Stuff That Is Always In This Report 
 
This report should be up on the SIG’s blog. I may go into 
greater detail and I will include screen shots as well. 
 
I’ve been lax in posting to the blog. I hope to correct this. 
Because our meetings are once a month and last for only one- 
and-a-half hours there is much more I can cover with the blog. 
Hopefully! 
 
If you have a special request for information regarding digital 
photography let me know. E-mail me using the address listed 
below. 
 
Check out the SIG Blog for other information and maybe info 
on what we will discuss at the next meeting. 
 
See you at the next meeting.  
 
Email: noccc.bgphotosig@gmail.com 
 
SIG Blog: http://nocccbgphotosig.wordpress.com/ 
 
Picasa Photos: http://picasaweb.google.com/noccc.bgphotosig 
 
 
This SIG meets in Science 127 at 9:00 a.m. 
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 Photo by Denji Ebisu 

 
Photo by Denji Ebisu

Advanced Digital Photography 
By Larry Klees, SIG Leader 

Last Month 
he March meeting was about 
High Speed Photography. 
A.K.A. how to murder a 

balloon in a dark room. 
 
If you aim a camera at a balloon and 
press the shutter button as the balloon 
is pricked you could take a thousand 
pictures before you manage to time 
things just right and catch the balloon 
at the precise moment it pops.  People have actually done this 
and gotten good pictures; but even with digital cameras, the 
process is expensive, and time consuming.  
 
There are several ways to do high speed photography. We had 
great fun with one method and captured lots of balloons in mid 
pop.  
 
The basic method works as follows. A camera is pre-focused on 
a balloon and the room is darkened. The camera shutter is then 
opened for a second or two. Since the room is darkened, the 
camera is recording nothing. During this long exposure the 
balloon is pricked. A microphone hears the balloon as it starts 
to pop. The amplified signal from the microphone is sent 
through an adjustable delay circuit to a trigger circuit. The 
trigger circuit then fires a high-speed flash that has a duration 
of about 1/10,000 of a second. This very short burst of light is 
captured by the camera to photograph the balloon in the act of 
exploding. Finally, after the balloon has popped the camera 
finishes its long exposure and closes the shutter. By properly 
adjusting the delay circuit, you capture the precise 1/10,000th of 
a second that you wanted  out of that one or two seconds. 
 
We used a variation of this method to create lighting that 
allowed the combination of the popping balloon with a portrait.  
 

It's as much fun to capture a person's expression as it is to catch 

the popping balloon.  
The lighting was modified with the addition of two Nikon 
SB800 strobes. These were set to operate as slaves so that when 
the Kodak strobe fired, it triggered both of the SB800s. The 
SB800s were set for 1/128th power to keep their flash duration 
as short as possible. 
 
A test picture was 
taken to demonstrate 
the process and every 
SIG member was 
invited to choose a 
balloon and a weapon. 
I offered an 
assortment of 
photogenic weapons. 
To my surprise, every 
single person chose the 
banana (with a pin 
hidden in the tip). 
Most also chose the 
option of putting a tiny 
amount of water into 
the balloon before 
inflation. The water 
droplets dramatically 
show where the 
balloon was before it 
popped. 
 
I forgot to mention that 
several cameras could 
capture pictures at the 
same time. Dinji 
realized that he need 
only open the shutter 
on his camera at the 
same time that I 
opened the shutter on 
mine and he got beautiful photos from a different angle. He took 
the photos of the blue and orange balloons to the right. 
 
While most point and shoot cameras can be coaxed into a one or 
two second shutter speed, people quickly figured out that they 
would rather put their memory card into my camera (swapping 
cards is also much faster than swapping cameras on the tripod). 
For SD & XD cards, a computer was used to copy the file from 
my compact flash card to their card. Every one got to take home 
their own picture of a popping balloon AND it was fun! 
 
This shot of an 
orange balloon has 
several points of 
interest. 
 
First note that 
compared to the 
other photos, the 
balloon appears 
almost intact. That's 
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because the time delay on the trigger box was reduced to catch 
the explosion earlier. Also, most of the hole is on the far side of 
the balloon. Second, note the way the extra lights have lit the 
interior of the balloon (2:00 o'clock position) compared to the 
outside. Third, note the reflections of all three strobes. The 
brightness of each reflection is proportional to the light 
contribution of the corresponding strobe. The bottom one is 
from the Kodak strobe on the floor. It creates the sinister under 
the chin style lighting. The one at the (9:00 o'clock position) is 
an SB800 which had a nearly equal contribution. It was aimed at 
the front of the model to create some extra highlights, keep the 
shadows from being too black and to bring out details like the 
texture in that leather jacket. The dim one near the center is 
another SB800 bounced off an umbrella and contributed only a 
small portion of the light. It softens all of the shadows. If you 
zoom in at 500% (in the electronic version) you can make out 
the shape of the umbrella. 
 
PHOTO TIP 
Each SB800 has adjustable power output; but, anything higher 
than about 1/64th power increases the flash duration and blurs 
the fast moving edges of the balloon. Adjusting the SB800s 
focal length to telephoto / wide-angle increases or decreases the 
brightness respectively. 
 
Quaketronics trigger 
delay controller. The 
signal from the 
microphone comes 
in on the pink mini-
plug. the ammount 
of amplification is 
adjustable with the 
gain knob. A middle 
setting works fine to 
detect balloon pops 
and reject a croud of SIG attendies. The signal is passed to the 
delay circuit which is adjusted with the delay knob. A very 
hastilly prepared dial (with marks for prefered delays) has been 
added to this knob. The delayed trigger is sent to the flash/strobe 
through the black cable. Longer delays yield pictures like the 
one of the yellow & blue balloons while shorter delays yield 
pictures like the orange balloon. Inserting a plug in the flash 
jack or the strobe jack turns on the power from the internal 9V 
battery as indicated by the green LED on the top. The unit also 
has an eye (basic photocell type of input) which was used for 
the water drop pictures that follow. (The camera makes more 
noise than dripping water making the microphone tricky to use.)  
 
Other photos of the trigger kit and popping balloons are on page 
15 of the 2011 March 6 issue of the Orange Bytes. 
 
Additional information about trigger controllers may be found at 
these web sites. 
 
http://www.quaketronics.com 
http://hiviz.com/kits/products.htm 
http://www.diyphotography.net/the-comprehensive-water-drop-
photography-guide 
 
List of equipment used: 

SLR w/ cable release on tripod  
Microphone on boom w/ tripod 
Trigger / control box taped to microphone's tripod 
Backdrop supported by two volunteers 
Drop cloth to capture the water from the balloons. 
Lights:  
 Kodak strobe on floor aimed upwards;  
 SB800 strobe on tripod;  
SB800 strobe /w Umbrella on tripod 
Focus and composing light on tripod 
 
Two questions came up related to the equipment used. 
The first was why so much equipment? 
The second was why such an indirect way of taking a picture? 
(Open the camera shutter • pop the balloon • microphone picks 
up the sound • sends it through a delay circuit • to trigger a 
small strobe • which then triggers a pair of high power strobes • 
finally close the camera's shutter.) 
 
One long answer deals with both questions. Using an acoustic 
trigger is one of the few economical ways to capture the balloon 
at the instant it pops. The adjustable delay circuit allows precise 
control of the instant captured. The small strobe has a very short 
flash duration to freeze the motion of the balloon. (It is also very 
inexpensive. It's a converted $5.00 Kodak single use film 
camera.) While the small strobe alone is quite capable of 
properly exposing photos such as these, I just wanted to fine 
tune the lighting with extra strobes I had on hand; and the 
easiest way to synchronize those to the small strobe was to use 
them in their slave mode.  
 
The SLR camera is not triggered directly because it has 
mechanical moving parts that can not be controlled with enough 
accuracy.  Therefore a convenient human speed of one or two 
seconds is chosen for the shutter speed (which requires a 
darkened room) and the strobe/s are precisely triggered by a 
controlled delay from the microphone. 
 
The focus / composing light was used as an aid in the darkened 
room and was deemed easier than controlling the fluorescent 
room lights. That forest of fifteen tripod legs was just to create a 
consistent environment for multiple pictures with many people 
involved. In fact no tripods at all are required if one 
photographer is photographing one subject since the strobes are 
so fast and the room is darkened. 
 
The same equipment can also be used for taking pictures of 
water drops. However; everyone was having such a good time 
with the balloons that the water drops will have to be covered at 
a future meeting. 

 
Thanks to those who helped with the clean up and packing. 
 

http://www.quaketronics.com
http://hiviz.com/kits/products.htm
http://www.diyphotography.net/the-comprehensive-water-drop-photography-guide
http://www.diyphotography.net/the-comprehensive-water-drop-photography-guide
http://www.diyphotography.net/the-comprehensive-water-drop-photography-guide
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 At the April meeting  
Taking pictures with a camera's built-in strobe is barely better 
than taking no picture at all. The result is harsh shadows in 
places where there should be none and flat washed out details. 
 
One alternative is to use "Available Lighting." This is frequently 
wonderful. Sometimes however, available lighting delivers 
images that are hopelessly dark; or it requires such high ISO 
numbers that the grain/noise destroys the image. 
 
Another solution is to get the flash off the camera. This needn't 
be expensive. Very fine strobe lights can be purchased for about 
$40.00. The quality of this light can be further improved with 
umbrellas. These are also inexpensive. 
 
Bring your camera to the April meeting. You will be able to 
experiment with adjustments of a strobe with an umbrella in 
both reflective and transmissive modes. 
 
We will also visit the Strobist website where you can get the 
best tips on the use of strobe lights and where to get the best 
prices. 
 
This SIG meets in Science 127 at 10:30 a.m. 

Microsoft Access 

By Bob Dickson, SIG Leader 
he March session began at our new time (Non - 1:30 PM) 
but in the same room, Sci. 306 
(following Access / Excel VBA).  

We dove right into reports.  Helen wants 
to be comfortable making reports before 
she puts away her Quilts project and 
starts on her Dolls project.  Access 
provides so many features to make 
unique reports that one simply has to be 
willing to invest considerable time 
'playing and experimenting' with the 
features to gain sufficient knowledge to make reports, but it'll be 
worth it when you get it!  I demonstrated making a report on 
smaller-sized paper (rather than the typical 8.5" X 11").  This is 
useful to print notices or smaller messages with or without 
pictures, and to size the picture to fit on the smaller sheet.  It's 
necessary to set the parameters on the physical print unit before 
working on the display in Access so one has to be familiar with 
the limitations of the printing device.  We also discussed and 
demonstrated making a copy of the app and working with the 
copy to avoid messing up a working app.  "Don't burn your 
bridges."  So far, we're working with Access 2003 since that is 
most familiar but we will be upgrading to Access 2007, which I 
have, and even Access 2010 which Helen has but has not yet 
installed.  I've prepared Access 2003 apps and opened them in 
Access 2007 which automatically converts them to the 2007 
format (upward compatible).  That's good, but it means we aren't 
yet digging into the features that are new in 2007 so we'll have 
to get more into that aspect soon.  Interested in building a 
database or just interested about databases?  Join us in Sci. 306 

from Noon - 1:30 PM.  We'll adjourn in time for you to get to 
the main meeting.  Hope to see 'ya. 
 
This SIG meets in Science 306 at Noon. 

Visual Basic for Applications 
(Access VBA)    

By Bob Dickson, SIG Leader 
he March session concentrated mostly on Excel VBA, 
with some small discussion on Access VBA.  We 
discussed the different approach to building userforms in 

Excel vs. Access.  Of course there are some differences since 
Access is a database app and Excel is a spreadsheet app.  
However, many of the features of building userforms is the 
same in both apps, making the building of userforms easier if 
one has some knowledge in one or the other language.  For 
myself, I was struggling with using "Access-think" while trying 
to build Excel userforms.   
 
Richard, a 20+ year vet with using Excel, provided excellent 
explanations of how to get the result I desired.  Yep, friends 
helping friends.  We discussed the differences possible in 
designing one's app, such as using ranges of cells on a single 
worksheet vs. placing various kinds of data on different 
worksheets: there are good reasons for doing it either way, and 
each has potential drawbacks to be considered.  Before writing 
any code, write out the requirements of the app so you can avoid 
reworking your code to include a 'gottcha piece of data.  We 
also experimented with placing forms and having them open and 
close on command.  There's enough similarity between VBA in 
the two apps to permit using knowledge in one to help in the 
other but there are plenty of differences to require one to put a 
little 'sweat equity' into being able to generate cool apps in 
both.  Got some questions / suggestions re VBA in Excel or 
Access?  Come up to Sci. 306 at 10:30 (new time started with 
the March session) and let's share your knowledge or work on 
your questions. 
 
This SIG meets in Science 306 at 10:30 a.m.. 
 

PC Q&A  
By Jim Sanders, SIG Leader  

his report is on two of the topics 
covered at the March 6 club 
meeting. One member asked 

about a problem with Kodak printer 
software. He said he had tried to update 
the software with a new CD that he had 
ordered from Kodak. When attempting 
the installation, the install program said 
that it could not install because there 
was already another version of the installer running on his 
computer. He said that he had tried to go to Add and Remove 
programs in control panel running Windows XP to uninstall the 
software, and it showed nothing to uninstall. He said he had 
tried the Revo uninstaller and a few other programs along that 
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line without success. That his conversations with Kodak's 
support had not been effective. 
 
He wanted to know how to deal with the problem. A couple of 
thoughts came to mind which I explained to him. One was to go 
to the processes tab in task manager, choose to show processes 
for all users, to click on the user name column to sort the 
running processes by who they belong to, and look at each one 
that was associated with his user name. These are all executable 
files with the extension of EXE. If you locate each file, and 
right-click on it to bring up the properties choice, one or more of 
them are likely to belong to Kodak. If those files are deleted, 
then the already running installation process should go away. 
That is a time-consuming process, and it is probably quicker just 
to Google each one. 
 
I suggested that there was also the possibility that Kodak, 
somewhat like Symantec and their Norton Removal Tool, might 
have a master uninstall program that he could download from 
the Kodak website. Several different software vendors now offer 
this kind of tool to deal with a botched uninstall effort. A third 
approach, that sounds rather horrific, and is certainly somewhat 
time-consuming, but in today's world, relatively cheap, starts 
with buying a new hard disk. Installing your copy of XP on the 
new hard disk, to keep it simple, wait one day, and then install 
the Kodak software. Searching the entire hard disk for software 
that was installed on that day would then tell you where all of 
the pieces of the Kodak software are located. 
 
The presentation of the day was on the PCIe Bus x1 Super 
Speed USB 3.0 add-in card, and how well it fared in transferring 
a 4.5 GB file from the internal hard disk to the external USB 
hard disk. The comparison was to use the same file, and use a 
stopwatch to see how long it took to transfer the file using the 
same type of USB 2 adapter and comparing it with the USB 3 
adapter. 
 
I had planned on doing this demonstration at the February 
meeting. In preparation for doing it, I went to Fry’s with the 
intent of purchasing a 500 GB 2 1/2 inch hard disk drive that 
was on sale along with an enclosure that had a USB 3 interface. 
However, the drive turned out to be a 5400 RPM unit, which I 
didn't think would be the best choice for a test. As a result, I 
purchased a Super Speed USB 3.0 to SATA/IDE adapter model 
# BT-350 made by BYTECC and a PCIe Bus x1 Super Speed 
USB 3.0 add-in card made by Sabrent. I then went to the 
meeting with those devices left sitting on the table at home so I 
had to postpone the full demonstration till March. I was able to 
compare the USB 2.0 transfer between an external hard disk and 
the internal hard disk in February. Using the same external hard 
disk enclosure, which happens to have an eSATA interface in 
addition to the USB 2.0 interface, I used the eSATA interface to 
transfer the same file. USB 2.0 took two minutes and 47 
seconds, the eSATA interface took one minute and 10 seconds. 
At the March meeting I was able to demonstrate the USB 3.0 
transfer of the same file, and it took one minute and 31 seconds. 
 
I ran into a problem with the Sabrent PCIe USB 3.0 card that I 
had purchased, and you should be aware of it. It appears that 
Sabrent sells at least three different circuit designs that all have 
the same model number and not all of them work well. The first 

one that I purchased failed. A Google search turned up the same 
failure symptoms and pointed out the differences in the cards. I 
was lucky in that there happened to be an older model return on 
the back of the shelf that did in fact work after I returned the 
failing card. Based on my experience, I would have to suggest 
you think twice about purchasing this brand of this type of card. 
 
The Shuttle computer that I do my demonstrations with only has 
2 expansion slots, a standard PCI and an x16 PCIe video card 
slot. As I wanted to keep the video card slot open in case I 
wanted to put a high-powered video card into the computer, I 
first started looking for a PCI bus card. There did not seem to be 
any regular PCI bus cards available. I started thinking about 
why that might be so and remembered that the PCI bus "Only" 
has a maximum bandwidth of 133 MB that is far short of what is 
needed for a USB 3.0 card to perform well.  The PCIe Bus’s x1 
capability of 250 MB per second is still only about half of what 
is needed. Hopefully, the USB 3.0 controllers that are built into 
motherboards have an interface that allows them to function to 
their full bandwidth. 
 
Still, if you have an older computer that doesn't have the USB 
3.0 capability, I would recommend that you consider purchasing 
one of these controller cards.  
 
 Hope to see you next month. 
 

Jim’s two SIGs meet in the Irvine Hall at 10:30 a.m. and 
12:30 p.m., respectively.  The first is the Beginner’s PC Q & A 
and the second is for everything and everyone else. 

Linux Desktop & Administrator  
By Bob Ray, SIG Leader 

ots of small 
GNU/Linux bits and 
pieces were discussed 

in our last meeting.  
However, one larger subject 
area that we reviewed was the 
Linux BASH Shell.  This was 
no small item.  We described 
in some detail what a Linux 
“Shell” is and what the shell does.  We gave an example of how 
to create a shell source program and then demonstrated how to 
execute that program as an interpretive interactive program from 
a text source file.  We took it slow as we walked through this 
presentation for the benefit of those relatively new to a 
GNU/Linux based computer system.  Some attendees were 
curious and enthusiastic while others seemed to just stare 
blankly at the projected screen presentation.  I was unable to 
evoke a response from some of those, as in; “Knock Knock, 
Hello”...the lights are on....”Is Anybody Home?”  I might add 
that our senior resident Linux Guru (Mr. Answer Man himself) 
was in the corner of the room, eyes closed and snoring “lightly” 
as not to disturb the rest of the group...we only wake him up for 
serious items of discussion.          
 

L
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In addition to, and as part of the above subject material we 
demonstrated how all programs running under the Linux system 
can legitimately “father” a child program.  This in turn can then 
again father another child or more children.  These are officially 
called: Yes, you may have quested, Child Programs. These are 
also referred to as Processes, and each Child/Process is assigned 
a Process Number that is managed by the guts inside the 
Linux/OS.  The magic of all of this is probably the biggest 
feature; and heart and sole of what makes up the GNU/Linux  
operating system.  Understanding how all of this works is 
extremely complex and complicated.  My intent in presenting all 
of this was to give some insight of what goes on “under the 
hood.”  Part of this demonstration was in starting a program that 
created a child process that again created a third child process (a 
grand Child).   While all of these were running, we went back 
and “canceled” the 1st program, the father program, by using 
various kill commands. This left the 2nd child process as 
“orphaned”---without a parent.  We then stopped the 2nd child 
process...this left the grandchild (the 3rd process) running as an 
Orphan and its parent (the 2nd process) was then left as a 
“Zombie” process.  Yes, this terminology is official GNU/Linux 
terminology...these are not terms that I am making up.  The 
“Zombie” program, although dead and not running, was still 
“standing” in RAM memory and taking up other resources, 
possibly disk space.  While the 3rd process, still a running 
process, was doomed to run and wander helplessly, and lost in 
the wilderness, possibly forever.  We then demonstrated, in part, 
how to check running processes.  How to analyze processes 
using the system monitor and how to take action if a situation, 
as the above, were to occur on your computer system. 
 
Many situations can unexpectedly occur on your system causing 
it to “hang” or start to run slow and “doggy” or perform 
“funny”.  The possibilities and conditions are seemingly 

endless.  Using some of these procedures, we 
demonstrated ways to help you determine what is 
wrong and how to take action to get your system 
back running properly.  However, after all of 
this, I must add that most people would probably 
use the old “blue screen” Microsoft “three finger 

salute” Ctrl-Alt-Del, or just turn off their computer then back 
on.  This does not necessarily solve the problem.  I would also 
add that someone might think this above problem is basically 
“no big deal”.  However, this is a “Big Deal” especially on 
network computers and servers. Or, if you are running jobs that 
may have important data and open files that you may have 
updated but the buffers have not been written out to the disk.  
Nuff said! 
 
The Gnome System Monitor can be invoked from the Bash 
Command line by entering the following: 
$ gnome-system-monitor [Enter] 
The same can be invoked from the Gnome GUI Desktop by 
clicking the GUI thumb icon from the 
System>Administration>System Monitor as shown 
here: 
The System Monitor display has four main function features: 
System; Processes; Resources; and File Systems.  By choosing 
and clicking on the Processes we can then see and use the 
Processes feature as shown in the Processes screen shot.  We 

can then view and see basically “everything” that is going on 
inside the Linux system.  The names of programs are shown 
along with the “owner” of those processes.  The Process Id is 
shown.  If a process (program) is causing a problem you may 
right click on that process.  A pop-up menu will then be shown 
with options and allows you to take a variety of actions.  
Caution should be used when changing or killing any of these 
programs. 

 

Continuing on with this current theme I will briefly describe and 
show an additional process management tool called and named 
“top”.  To execute this program from the command line the user 
would key in the following as shown: 
$ top [Enter] 
A screen is then shown giving information and statistics about 
the processes running environment.  The upper part of the 
screen gives information pertaining to the overall running 
system while the bottom portion of the screen shows a list of 
processes currently resident and under Linux management.  
Rather than describe all or even some of these elements I 
suggest the reader refer to and use the man(manual) 
documentation page by keying in: 
 
$ man top [Enter] 
on the terminal command line.  Many of the features are shown 
in the attached screen shot of a “top” running command process.  
The information presented here and to be presented in the future 

will give you tools to help manage your computer systems from 
the inside.  
 
These SIGs meet in Science 131 at 9:00 a.m .and 10:30 a.m. 
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Microsoft Office  
Tia Christian, SIG Leader 

hese sessions are an open forum for problems incurred 
using Microsoft Word, Excel, and 

Outlook and their resolutions.  During these 
SIG sessions, topics have been discussed on 
creating Labels in Word and exporting to 
Excel and printing them.  Primary session 
topics have included the upgrade from 
Microsoft Office 2003 to Microsoft Office 
2007; using Add–In; e-mail compatibility 
issues from Microsoft Office 2003 to 
Microsoft Office 2007; installation 
requirements for installing Microsoft Office 2007 on a PC using 
Windows XP as well as one using Vista 2007; PowerPoint 2003 
compatibility issues with a slide presentation consisting of an 
AVI and file viewing. 
 
This SIG meets in Science 109 at 9:00 a.m. 
 

Visual Programming 
Anson Chapman, SIG Leader 

his SIG is lead by Anson Chapman 
and is a continuing discussion group 

about computer programming using 
Visual Basic, Visual Basic Script, Visual 
C, Visual C++ and Visual J++ for 
Beginners.   
 
This SIG meets in Science 111 at 
9:00 a.m. 
 

Understanding Operating Systems  
Charlie Moore, SIG Leader 

his SIG is lead by Charlie Moore and 
is a continuing discussion group 

about Operating Systems for computers. 
 

This SIG meets in Science 111 at 
10:30 a.m. 

 
 
 

(Continued from right-hand column) 
will not happen. I’ll be visiting my grandchildren near Atlanta, 
Georgia, and, having not been able to find a substitute, at this 
point I must conclude the next Mobile Computing SIG will be 
May 1. I’ll still post a Power Point presentation at 
http://www.noccc.via.us/mc/2011.0403 and I’ll notify those on 
the email list, for this purpose, as soon as it is ready for viewing. 
April theme: Games (for kids). The May theme: Cost Justifying 
Mobile Computing devices. 
 
This SIG meets in Science 109 at 10:30 am. 

Mobile Computing SIG 
 

Ben Lochtenbergh, SIG Leader 
 

he March meeting was well 
attended, thank you. I thank John 
Lundgren for getting the 

overhead projector going. There was 
one new (to our SIG) Mobile 
Computing device in the audience, an 
Android HTC EVO. Well, there was 
also the new Motorola XOOM tablet, 
which I bought February 24. If you were 
to look at the Power Point Presentation 
at http://www.noccc.via.us/mc/2011.0306 
then you would see images, a buying 
experience, and links about this 
marvelous device. This SIG meeting 
again had a list of ten demonstrations 
that I could do, with DROID 2 or XOOM. The theme of the 
month was Social Networking, in honor of the Main Meeting 
presentation by Mitch Siegel. From the Internet presentation, I 
clicked on the links to start Facebook, LinkedIn, and Twitter, 
but didn’t log in since there was no specific request, and really 
not much time. Time was probably better used by going through 
all ten, mainly a talk about my experiences, and a few instances 
of showing the devices in front of the room. I demonstrated the 
barcode scanner, using a flyer that one of the members had 
brought in. I showed my Starbucks card widget for ordering 
coffee, which was clearly visible to all attending.  
 
There remains the problem of displaying the small device 
information live onto the ‘big screen.’ Even though I’ve done a 
fair amount of research and asked for assistance with this, I’ve 
not succeeded. I joined an online forum to ask that question. I 
found others on the forum and elsewhere asking the same 
question. One schoolteacher asked it much better than I ever 
could, but he too to-date has not received a good 
answer/solution. I visited my local Micro Center store, asked 
part of the question (for my XOOM that has HDMI output). The 
guy immediately answered: “Yes, we have one for $89” and 
walked me to the isle. They had four for sale, the only problem, 
VGA to HDMI, the reverse of what I want/need. This, however, 
gives hope for the future. Being at the front edge of this 
technology has its hurdles. Going to VGA is like going back 
into old technology, (which doesn’t promote the sales of new 
style monitors), Perhaps, a manufacturer will make a backward 
compatibility adapter device some day for people to buy. 
 
Another issue, I’ve been posting Power Point presentations on 
the web for PCs using an older version of Microsoft Office, a 
feature Microsoft has discontinued. I don’t expect Microsoft to 
change, not even for the Windows Phone 7. For now, I’ll 
continue this way, but I’m looking for better ways. Reasons: 
O2K doesn’t allow for slideshows html files, only full power 
point html postings, and more important, Android can’t render a 
Power Point presentation completely, it only shows the slide 
names, while the BlackBerry OS doesn’t even show that. 
Obviously, that method has no future. The April SIG probably 
  

T 

 

T 

T 
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Transportation Information 

Meeting Information 
The NOCCC meeting is held at Chapman University, in the 
Hashinger Science Center and Irvine Hall, near the northwest 
corner of Center Street and Palm Avenue. 

Parking Information 
Most of this information is on the back cover.  For more 
information, see www.chapman.edu/map/parking.asp.  A map 
of the Chapman University campus is also available at 
www.chapman.edu/map/map.pdf.  

Bus 
Several Orange County Transportation Authority (OCTA) buses 
service Chapman University.  Route 54 runs East and West on 
Chapman Ave.  The 59 runs North and South on Glassell 
Avenue, but doesn’t start early enough for the 9:00 a.m. SIGs.  
Get the most current information or use a trip planner at 
www.octa.net.  OCTA also has a Consumer Information Center 
at (714) 636-7433 (RIDE). 

Railroad           
Metrolink trains can get you to the NOCCC meeting from the 
Inland Empire.  There are stops in the cities of Riverside, 
Corona, and Anaheim Hills.  Parking your vehicle is free at the 
train station. (See M on map below.) 
On Sundays, Inland Empire-Orange County Line train 859 
leaves San Bernardino destined for Orange County at 8:55 am.  
For the return trip, train 860 leaves nearby Orange Metrolink at 
4:30 pm.  The Metrolink station is four-and-a-half blocks from 
Chapman University.  For specifics regarding your trip, check 
the web site: http://www.metrolinktrains.com or call 1-800-
371-5465. 

 

Board Meeting Minutes 
March 7, 2011 

he NOCCC Board Meeting was held at President Jim 
Sanders’ residence on Monday, March 7th. Jim called the 
meeting to order at 7:35 PM.  

 
All members attended except Tia Christian.  
 
Secretary’s Report (by Jim Sanders):  Jim took notes at last 
month’s meeting in Ted Littman’s absence. It was motioned to 
approve the Secretary’s Report of the Board Meeting as 
contained in the March 2011 Bytes; this was seconded and 
approved by all in attendance.  
 
Treasurer’s Report (by John Heenan): Net income for coffee, 
cookies, and donuts was -$7.00 with purchases of supplies 
exceeding income. The General Raffle earned $87, but this was 
offset by the cost to purchase the two hardware and two 
software prizes. Two club shirts were sold for a club loss of $12. 
Total dues received was $105. 
Memberships: Regular (1-yr.) = 168, Regular (3-yr.) = 12, 
Family = 6, College Student = 1, Newsletter = 12; Total of 199           
Members, up 5 from the previous month. In February, there 
were 17 renewals and 1 new member. The Board accepted the 
Treasurer’s report.  
 
Main Meeting: The scheduled speaker was Mitch Siegel at the 
March meeting. There were about 35 attendees. Several positive 
comments on the presentation were made by Board members, 
but concern over it running long. See report elsewhere in this 
newsletter. 
 
Opening & Closing:  Richard set up the coffee & 
donuts/cookies tables in the lobby of Irvine Hall. There were 
with doors not being opened not opened, requiring a call to 
Chapman U. Security. Preparation of coffee was delayed. There 
is a continuing problem with some people shorting the 
collection can. Each donut sells for $1, not 2, 3, or 4 for $1!!! 
This is an honor system. 
 
Next Scheduled Meetings:  The next Main Meeting is 
Sunday, April 3rd, followed by the BOD meeting on 
Monday, April 4th at the President’s residence.  
 
Committee Reports 
 
Programs: We do not yet have a commitment for a speaker for 
the April meeting, Several possibilities are being explored. Jeff 
Monday has changed positions at Apple and will not give his 
proposed talk on Apple’s IPAD & IPHONE. 
 
Public Relations (by Mary Cornett): Nothing to report.  
 
 Membership (by Ben Lochtenbergh): Nothing to report. 
 

T

Club Business 
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Publications & Reviews (by Ted Littman): One new software 
program was taken for review at the meeting on Sunday. One 
book review is still outstanding due to personal problems. The 
March newsletter was only 24 pages since Ted missed the 
February meeting and was unable to provide Gerry with raffle 
prizes so the Raffle was cancelled; hence no raffle winner 
photos. Ted indicated that he would probably be able to do the 
April newsletter, but might miss the April meeting and probably 
not be able to put the May newsletter together. Steven 
volunteered to fill in. Ted will provide a template in Word 
format. for preparing the next newsletter. All inputs for the next 
newsletter are due by Saturday, March 12th since this is another 
short production month. No reviews by NOCCC members were 
in the March newsletter.  
Raffles: (by Gerry Resch): The March raffles featured several 
“special” hardware and software prizes.  $87 was taken in, 
offset by the cost of four purchased items. 18 parking stubs were 
turned in for free raffle tickets. Ted will provide software and 
books for April and Jim will purchase items for the Raffles.  
 
SIGs (by Dallas Hazleton): Dallas did not attend the March 
meeting. It was noted that the Microsoft Word, Excel, & 
Outlook SIG leader did not attend. Other SIGs were held and 
attendance varied. 
 
Old Business: Jim discussed the NOCCC web site and 
indicated that he now is able to keep it updated. 
 
New Business: Ted reminded the Board that the club’s 
anniversary will be celebrated at the next meeting followed by 
elections in June and the need to obtain volunteers for the 
various BOD positions. In addition, we need to get a 
commitment from Chapman U. for meeting dates beyond May 
1. Jim said a cake and punch will be procured and set up during 
the “Pig SIG” outside Irvine Hall at the next meeting. Gerry said 
we need to post a list of candidates in the May OB. Jim queried 
the attendees regarding serving for the coming year and all 
seemed amenable. Ted’s ability to continue depends on his 
wife’s health status.  
The meeting was adjourned at 9:15 P.M. 
 
NOCCC Secretary Ted Littman prepared this report. 
 
 

NOCCC Fee Schedule 

he fee schedule has been set up to increase club 
membership, attract people with an interest in computing, 
and attract local computer-related businesses to place ads 

in the Orange Bytes with or without becoming NOCCC 
members.  We are also offering members the opportunity to 
help our club financially by making donations that should 
be income-tax deductible since we are chartered as a non-
profit 501(c)(3) organization.  Donors will be acknowledged in 
the Orange Bytes and the Membership level will be shown on 
the Member’s Badge. Your regular dues is tax deductible! 
 
Membership Level ($) 1 Year 3 Years 
Individual Member............................................. 35.........90 
Each Additional Family Member ...................... 15.........45 
Full-Time* Enrolled College Student ............... 20 
Enrolled High School Student.......................... 15 

*Minimum 12 Semester Hours 
Business Member + Ad (Business Card) .......180 
Business Member + Ad (¼ Page, ½ Page) .....465 , 800 
Business Member + Ad (Full Page) .............1,475 
 
Membership Donations ($) 
Contributing Member.........................................75 
Supporting Member .........................................100 
Advocate Member ............................................250 
Patron Member .................................................500 
 

Thanks to Our Members Who 
Renewed in February 2011 

 Malcom Bruce 
 Jay Chaisson 
 Kevin Chang 
 Francis Emanuel 
 John Heenan 
 Jackie Jong 
 John Meiling 
 Gary Miller 
 Alan Pearlman 
 Bill & Helen Phillips 
 John Robe 
 Robert Sailee 
 Jerry Schmedeke 
 Thomas Skudlarski 
 Douglas Steiner 
 John Szary 
 Ole Thompson 

 

Thanks to Our New Member Who 
Joined in February 2011 

 Patricia Adelekran 
We invite you to take an active roll in running NOCCC and 
planning its activities.  Please contact President Jim Sanders 
or one of our other officers at a monthly meeting or by e-
mail (editor@noccc.org).  

NOCCC Bylaws  
You may view the club’s Bylaws at our website:  
http://www.noccc.org/bylaws/. 

From the Desk of the Membership Chairman 
 
By Ben Lochtenbergh, bal@msn.com 
  

ur raffle ticketmaster, Gerry Resch, noted that 18 
parking tickets were redeemed for general raffle tickets 
after our last Sunday meeting. Indicating the 

underground parking facility incentive works. I, myself, 
redeemed two tickets, for one for February and one for January 
parking. Other members did the same. I’d like again recommend 
parking under the football field; it’s much nicer than parking on 
the street. 

T 

O
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Your business card 
would look good here!! 

 
For information about advertising in the 

Orange Bytes, contact editor@noccc.org.  
 

Classified ads by NOCCC members cost $5 
for 1-25 words and $10 for 26-50 words. 

Some of you may not know, or need reminding, that one of our 
club members, Ed Schwartz, publishes a weekly column in The 
Orange County Register, each Wednesday. I bought the paper 
March 9. Page 19 of the News, in the Business section, under 
the heading Technology, has his column. He mentions: our club 
by name, edwardns.com Contact Me menu, and archives of his 
previous columns. 
 

Pig SIG Open to All 
 

eet us outside Irvine Hall from 
about noon to 12:30 p.m.  There 

are several benches where NOCCC 
people gather, eat and chat.  Just look 
for the member badges, grab a chair 
and join in!  This is an informal group; 
so many different subjects are 
discussed.  It’s a great opportunity to 
mix, mingle, and network! 

 
Free coffee & tea at the April meeting! 

 
Donuts $1/Each & Cookies $.25/Each 

No Freebies! 
Put your dollars & quarters in the 

collection can. 
 
Birthday Cake, Cookies, & Punch at Noon!!!!!!!! 

 
 
 
 
 
 
 
 
 

FREE AD SPACE 
f you are an NOCCC member, and have a computer-related, 
non-commercial or “Talent Available” ad that you would 
like to have placed in this newsletter or on the NOCCC web 

site, send an e-mail with a copy of your business card or ad to 
the NOCCC Editor at editor@noccc.org. 

 

 

 

(Continued from page 11)  
The NOCCC Reviews Editor, Ted Littman, (714) 779-1936, 
reviews@noccc.org is regularly sent copies of books or software 
by the publishers for review by one of our members.  We need 
NOCCC members to take these items and commit to 
reviewing them promptly.  The reward for doing a review is 
that you get to keep the book or software.  If we do not 
review them, they may stop sending these items in the future. 

Important!  There are two articles at the following link.  One 
provides suggestions and guidelines for preparing a review or 
article for the Orange Bytes.  The second provides guidelines for 
submittal. Please read both. The link 
is:www.noccc.org/bytes/info/index.html 

The NOCCC reserves the right to refuse to publish any article or 
review at the discretion of the editors of the Orange Bytes 
newsletter or officers of the club.  Reasons may include, but are 
not limited to, length and quality of the review or offensive 
nature of the product or of the review. 

M 

I
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Publication Information 
Orange Bytes is published monthly by: 
North Orange County Computer Club  

P.O. Box 3616, Orange, CA 92857 
 

All opinions expressed herein are those of the individual 
authors only and do not necessarily represent the opinions of 
the NOCCC, its officers, Board of Directors, the Orange Bytes 
newsletter or its editors.  The NOCCC does not guarantee the 
accuracy or the correctness of advertising or articles in the 
Orange Bytes, nor does the NOCCC intend to endorse, rate, or 
otherwise officially comment on products available.  
Therefore, the readers are cautioned to rely on opinions 
presented exclusively at their own risk. 

Trademarks/Copyrights — The mention of names of products 
in this publication without trademark or copyright symbols does 
not imply that they are not so protected by law.  All trademarks 
are the property of their respective owners. 
Production — Orange Bytes was produced with Microsoft 
Word ® using the True Type fonts Arial, Bauhaus 93 and Times 
New Roman. 
Printed by: Creative Technology 
                         5959 Palmer Blvd. 
                         Sarasota, FL 34232—28  
                         800-533-1031 

He that blows the coals in quarrels that he has nothing to do with has no right to complain 
 if the sparks fly in his face. 

Benjamin Franklin 
 

QUICK MEMBERSHIP APPLICATION/RENEWAL 
Date: ________________  I am a new member  
 This is a renewal; my membership number is  _______ 

PLEASE PRINT! 
Name ______________________________________________________ 
Address____________________________________________________ 
City _______________________________________________________ 
State_______ Zip _______________ Phone (______) ______-________ 
email______________________________________________________ 
Fees: see page 25 for fee schedule; $35 for single membership. 
Since the North Orange County Computer Club is incorporated as a 501 (c) (3) 
organization, checks are 100% tax deductible when made payable to North 
Orange County Computer Club. 

Amount enclosed $___________________ 
MC / Visa No. ________________________ Expires ________ 
Please make your check payable to North Orange County Computer 
Club and mail with your application to: 

North Orange County Computer Club 
PO Box 3616 
Orange, CA 92857 

Membership Renewal 

When you turn in your 
Membership Renewal check, 

PLEASE fill out a Membership 
Renewal Application. 

 

Memberships may also be 
renewed on our Website: 

https://mmm1427.rapidsite.net/
citivu/noccc/order3.html 

Send e-mail address changes 
to membership@noccc.org 

 

 
Commercial display advertisements  

are welcome, contact  
editor@noccc.org.  

 
RATES 

 One Page Vertical .......... 7.0” x 9.5” ...............$150  
 Half-page Horizontal ..... 7.0” x 5.0” .................$80  
 Half-page Vertical  ......... 3.5” x 9.5” .................$80 
 Quarter-page ................... 3.5” x 5.0” .................$45 
 Business Card ................. 3.5” x 2.0” ................$ 15 
 Center Spread................ 14.0” x 9.5” ...............$300 

Deadline: Tenth of the month  
 

Discounts: 3months=10%, 6=15%, 12=20% 
If you are interested in advertising in the publications of 

multiple User Groups throughout the region or nationally, 
you can learn more by contacting http://www.apcug.org 

 
Readers, please tell our advertisers that you saw their ad in the 

Orange Bytes 

mailto:editor@noccc.org
http://www.apcug.org
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mailto:membership@noccc.org


 

28 Orange Bytes 

Consider all that you get with membership and Join Now! 
 Meetings. Keep up with what’s going on in the computer 
world.  Hear outstanding industry representatives make 
presentations of the latest and greatest in computer products. 

 Special Interest Groups. Our SIGs cover a broad spectrum of 
computer issues.  Whether you are a beginner or a power user, 
attend the lectures and demonstrations, and share your 
knowledge about computers. 

 Raffle Drawings. We have distributed thousands of dollars 
worth of hardware, software, and books as prizes at our Main 
Meeting.  

 Consignment Table. We have a consignment table during 
even-month meetings, in which members can sell or buy all 
kinds of computer & software items. 

 Get help with your current computer problems.  In the 
Random Access portion of the Main Meeting, you may ask 
your question of the entire assemblage.  More than likely, 
someone will have the answer. 

 NOCCC Help Line. NOCCC volunteers, experts in their 
fields, are ready to assist you with your computer problems.  
They can be contacted by email or by telephone. 

 The Orange Bytes Newsletter. Our award-winning newsletter 
reports on club activities and provides articles about current 
computer issues and reviews of software and books. 

 Product Reviews. Write a review for the Orange Bytes and 
keep the software, hardware, book, or CD! 

 Volunteer Work. We have numerous interesting assignments 
available.  As an all-volunteer organization, you can join with 
other members in a variety of activities: solicit newsletter ads, 
write articles for our newsletter, conduct a seminar, run a SIG, 
give a Main Meeting presentation, show new members 
around, join a committee, assist in setting up the meeting or 
participate in computer-related community volunteer work. 

Become an NOCCC member by signing up at the 
Reviews/Membership Desk during a general meeting, usually 
the first Sunday of the month.  Or simply fill out the form on the 
reverse side of this page and send it in. 
Meeting Information — The NOCCC meeting is held at 
Chapman University, in the Hashinger Science Center and 
Irvine Hall, near the northwest corner of N. Center St. and E. 
Palm Ave.  
Parking Information - Chapman University’s main parking lot 
is the underground Lastinger Parking Structure under Wilson 
field on the north side of the campus. Enter from Walnut 
Avenue, just east of Glassell Street. Parking is not free on 
Sunday, even if the gate is up.  However, they have moved the 
permit vending machine about 100 feet south of the entry 
area. There is a second machine closer to the south end of 
the lot.  Find one, buy a permit, and put it on your dashboard.  
Do not park in any other lot, in a reserved space, or back into a 
space. 
Free street parking also is available on the campus-side of the 
streets only. Parking in front of any residential housing will 
result in an expensive parking ticket. A City of Orange public 
parking lot, located on the southwest corner of E. Maple and N. 
Orange, is also free and only 2 blocks from the meeting. For 
more information, see the Transportation Information section.  
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Members: Your expiration month  
and year appear on your mailing  
label. Please renew promptly,  
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Dated Material - Please deliver by April 2, 2011 

Dogs of C Kennel by Mick and

Are You an NOCCC Member? 
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